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1.

Introduction

1 What Is Bria?

Briaisthe latest telephony application from CounterPath, allowing users to enjoy multimedia communications
in adynamic new way. Featuring an intuitive new interface, Briais expanding the softphone experience by
making it even easier for users to make Vol P (Voice over Internet Protocol) and Video over IP calls, see when
contacts are available and send instant messages.

Designed to work over internet-based phone systems, Bria provides Vol P solutions using an internet-based
telephony server within your company’s local area network and/or over your local internet Vol P service
provider.

Standard Telephone Features

The CounterPath Multimedia Communicator Bria 2.0 has all the standard telephone features, including:

Call display and Message waiting indicator (MW]1).
Speakerphone and Mute.

Redial, Hold, Do not disturb.

Cadll history — list of received, missed, and dialed calls.
Call transfer.

Six-party audio conferencing.

Three-party video conferencing.

Enhanced Features and Functions

The CounterPath Multimedia Communicator Bria 2.0 also supports the following Vol P features and functions:

Instant messaging and presence using the SIMPLE protocol.
Managed contact list —importing and exporting contacts between Bria and other applications.

Support for Intel® Centrino® Mobile technology, alowing Briato provide more consistent quality of
service across both wired and wireless networks using industry standards such as 802.11e.

Log in with up to ten different Vol P service providers.

Automatic detection and configuration of audio and video devices.
Acoustic echo cancellation, automatic gain control, voice activity detection.
Support for the following audio codecs:

AMR Wideband (G.722.2), Broadvoice-32, Broadvoice-32 FEC, DV14, DV14 Wideband, G.711alaw,
G71luLaw, G723, G726, G729, GSM, iLBC, L16 PCM Wideband, Speex, Speex FEC, Speex Wideband,
Speex Wideband FEC.

Support for the following video codecs:
H.263, H.263+ 1998, H.264.
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« Automatic selection of the best codec based on the other party’s capahility, the available bandwidth, and
network conditions. Bria switches the codec within a call in response to changing network conditions.

*  SIP compliance to 3261 SIP standard.

e STUN and ICE NAT traversal. XTunnels for firewall traversal.

e Support for DTMF (RFC 2833, inband DTMF or SIP INFO messages).
»  Support for languages. Bria can be configured for English or German.




2 Installation and Setup

2.1 Getting Ready

After choosing a Vol P service provider, you will need the following information:

* User name

» Password
» Authorization Name (if applicable)
 Doman

» Firewall traversal and other network information; see “ Configuring Accounts’ on page 55.

System Requirements

Processor Minimum: Intel Pentium 111 1.3 GHz or equivalent
Optimal: Pentium 4® 2.4 GHz or equivalent
Memory 512 MB RAM
Hard Disk Space 50 MB
Operating system Windows® 2000
Windows® XP
Connection IP network connection (broadband, LAN, wireless)
Sound Card Full-duplex, 16-bit

Microsoft Internet Explorer® 6.0 or later.

Multimedia Device Requirements

Briarequires both speakers and a microphone to make calls. Any of the following configurations are
acceptable:

» External speakers and microphone
*  Built-in speakers and microphone
*  Dual-jack multimedia headset

*  Bluetooth® multimedia headset

*  USB multimedia headset

e USB phone.
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Optimized Devices

Briais optimized to work with the following:

Actiontec Internet Phone Wizard

GN Netcom GN 8120 USB and GN Netcom 8110 USBXP
Plantronics CS50-USB Wireless Office Headset System

Polycom® Communicator C100S Wideband USB Speakerphone
TigerJet RJ11 to USB Phone Adaptor (incorporating the Tiger560C)
TigerJet USB Phone Set (incorporating the Tiger560C)

Yedink USB-P1K USB hand phone

Video Cameras

Calls made with Briawill work without avideo camera, but one is necessary to allow other parties to see your
image. Briawill work with most USB video cameras.

2.2 Installing Bria

1. Run the Bria setup executable file and follow the prompts in the install wizard.

2. At thefinal step of the wizard, select Launch Briato start using the Multimedia Communicator.

3. Click Finish to complete the installation. The Log In dialog box appears. You can press Cancel to exit for

now, or you can set up your CounterPath Bria account immediately; see below.

Uninstalling Bria

Uninstall Bria as you would uninstall any other program: launch the Windows Control Panel, and select Add or
Remove Programs. Follow the prompts.
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2.3 Configuring Bria

1. If Briaisnot aready running, start it as you would any other program: Use the Windows Start menu
or double-click the desktop icon. Bria appears. &

2. From the Briamenu, choose File > Account Settings. The SIP Accounts window appears.

Enabled | Account | Domain | Username | Displary Hame | Edit
W lscountt JEWREy | |

fccount 2 Emply [ake Default
Accounk 3 Empby
Accounk 4 Empby
Accounk S Emply
Accounk & Empby
Accounk 7 Emply
Accounk 8 Empby
Accounk e Empby
Accounk 10 Emply

il

OOO0OoOoooog

Close

3. Click Edit. The Properties of Account window appears.

Account 1 Properties il

Accourt |\-"0icemai|| Topologyl Securit_l,ll Advancedl

Account I Account 1

r~User Details
Display Mame I Joseph
Usernare I jsankos

Password I

Authorizakion user name I

Ciamain I domaind,com

—Damnain Proxy
[V Reagister with damain and receive incaming calls
Send outbound via:

" domain
© prowey Address I

% target domain

—SIP Listen Part
[~ Manual override |9456

Dialling plan I

ok I Cancel | Apply |

4. Inthe Account tab, complete the User Details area with the information obtained from the Vol P service
provider.
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5.

Complete the remaining tabs as specified by the service provider or to suit your setup. Settings that you
may heed to change immediately include:

*  Account tab, Domain Proxy area.
» Topology tab, if your computer is on a network and/or behind afirewall.

e Security tab, if you want to set up secure calls.
For more information, see “ Configuring Accounts’ on page 55.

Setting up for Voicemail

Your Vol P service provider may offer voicemail. If it does, then you can set up some voicemail featuresin Bria.
See “ Account Properties — Voicemail” on page 58.

Setting up a Contacts List

Use of a Contact list is optional, but is the most efficient way to make calls. You can set up contacts in several
ways:

During acall that you place or receive, you can add the other party to your contact list. “Handling an
Established Call” on page 14.

You can add numbers to the Contact list one by one. See “ Adding a Contact” on page 29.
You can import a contact list from afile or from another application. See“Importing Contacts’ on page 29.

For general information on contacts, see “ Contacts Tab” on page 27.




3 Using Bria

3.1 Starting Bria

If Briais not already running, start it as you would any other program: Use the Windows Start menuor 4 ¢
double-click the desktop icon. Bria appears.

Receiving a Presence Request

If availability isenabled, then at any timeyoumay geta (o0 -
Presence Reguest dialog box. For information on this
request, see “ Availability” on page 34.

Kokila (kpereira) would like to see your status when you are onling.

Selecting 'Block” will prevent this person from communicating with you.

Allow and Add to Contacts Allow Block

3.2 Shutting Down

To shut down Bria, choose File > Exit. Or press Ctrl-Q.
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3.3 The Onscreen Multimedia Communicator

Bria menu. See below. File — View Contacts Actions Help

#, "Available -

- C-

Call panel. See
page 10.

Enter name or number

Phone Book

Phone Book panel. i

See page 27. L-\

= Friends
= Home

= Work

4% COUNTERPATH

The Bria Menu

File
* My Profile. See page 41.
»  Preferences. These settings control the way that you work with Bria and apply to all accounts. See page 42.

»  Account Settings.These settings control how Bria interacts with your Vol P service provider, and are set
individually for each account. See page 55.

e Sign Out. Tolog off and minimize Briato the system tray. If you click on the Briaicon in the status bar, the
L ogin screen appears.

»  Exit. To shut down the application. You can also exit by pressing Ctrl-Q.

View
»  Changethe GUI. See “ Showing and Hiding Parts of the Multimedia Communicator” on page 9.
» Select the language. After changing the language, you must restart Briafor the new language to be used.

Contacts

Lets you work with contacts. Everything in this menu except for import and export can also be performed
directly in the Phone Book panel.
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For information on these actions, including import and export, see page 27.

For information on managing blocked contacts, see “Privacy” on page 39.

Actions

Lists the actions that you can perform, depending on the current “state” of Bria. For example, if a contact is
selected, it lists al the actions that can be performed on that contact.

Help

Provides access to various service-rel ated features.

Showing and Hiding Parts of the Multimedia Communicator

Restore to large view

Show/hide Dial pad

Showr/hide Video panel

View Contact=  Actions  Hel

Unthe phone - CE 3 1 missed

=y M R .
Move Call panel to separate window.

This button is enabled only when at
least one call is in progress.

e (0@ (-5 8«

Call establizhed
rsantos

| 00:00:42

Add to Contacts Options -

Close Call panel (only Call entry field will
remain). Click again to open

Phone Book

Contacts
EARN

% Friends
Kokila

Move Phone Book to a separate window

Show/hide Phone Book

= Home
= Work

4% COUNTERPATH

Drag to resize

You can still receive calls when Briais hidden or minimized.

If you exit when Briais minimized or in Deskbar mode; Briawill start next time as minimized or in Deskbar
maode.
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3.4 Placing a Call

You can contact someone using:

» A softphone address (kpereira@domain.com)
» A traditional phone number, if supported by your Vol P service provider
You can place a call when another call isaready in progress. Thereis no limit to the number of calls you can

make, although eventually the quality of audio and video will degrade because of limitations on the computer.
We recommend no more than six concurrent calls.

File View Contacts  Actions

 "OnThe phone = Other calls are on hold

Redial Current Calls bar

Open/close Video panel =" ii" (:- - A Call toolbar

Enter name or number
Call entry field

Click a button to place the call.
If the Video panel were open, a
Video Call button would also

appear here.
Phone Book

Contacts Filter
%

& Friends
Kay
Kevin - Pending request
2 Kokila
{§ r=antos - On the Phone
= Home
&= Work

4% COUNTERPATH

1. If you have acamera on your computer, decide how you want to handle video for this call:

*  The Video panel must be open if you want to send your video immediately. When the Video panel is
opened, the Video button appears on the Call panel.

(You always have the option of starting the call without video and then adding it later).
» The Video panel can be opened or closed if you do not want to send video.

2. Placethecall. See the table bel ow.

The new call is added to the Current Calls bar. You will hear aringing tone while Bria attempts to make a
connection.

3. Oncethe new call is established, switch between different calls by clicking the tab in the Current Calls bar.

10
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How From the ... Description
Keying Dialpad or computer (ﬂ
keyboard 1. If another call iscurrently in progress, click on the Call toolbar.

A new Call Entry area appears. The current call is put on hold.

2. Enter the softphone address or number in the Call entry field using
the dialpad or the computer keyboard.
For the name, you can enter the entire softphone address
(kpereira@domain.com) or just the name (kpereira).
Asyou type, a suggestion for completing the entry may appear.
Choose the suggestion or keep typing.

3. Click Call or Video Call (if the Video panel is opened), or press

Enter.

Drag-and-drop | Contacts or History tab in the | Drag an entry from the Contacts or History tab. The call is placed
contact or Phone Book panel immediately.
previous call .

If the tab contains lots of contacts, first use the O field to filter the

list.
Right-click a Contacts or History tab in the |Right-click an entry from the Contacts or History tab and choose Call or
contact or Phone Book panel Call with Video. The call is placed immediately.
previous call

If the tab contains lots of entries, first usethe Q field to filter thelist.

Redial Redial button Click Options and choose Redial. Or click the Redial button.
The call is placed immediately (without video).

From Outlook If you have set up contacts in Microsoft® Outlook®, you can place a
call using aPSTN number (but not a softphone address).

1. Double-click the contact in the contact list in Outlook. The Contact
dialog box appears.

2. Click the <91_R‘°} in the top left corner and select the phone number to
dial. Assoon asyou release, Briawill be brought to the front (or will
be started) and the call will be placed.

You may need to revise the dial plans for your accountsin order to
support the format used in Outlook. For example, if phone numbersin
Outlook all have a*+9” prefix, you must ensure the dial plansfor your
accounts strip out the + correctly. For details, see “Dialing Plan” on
page 73.

For information on how Bria and Outlook contacts work together, see
“Exporting Contacts’ on page 30.

Placing another Call

To place anew call (without hanging up on the current call), click the Start another Call button. In the Current
Calls bar, atab appears for each separate call.

File View Contacts  Actions  Help

[ —
¢4 "On the phone -

Start another Call
button

Call establizhed
| rsantos

11
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Hiding your ldentity

You can hide your identity on a call, so that the other person will not see your ID on their phone.

On the Call control bar, choose Options > Hide my Number for this Call. 5 appears on the Call control bar for
this call. Place the call in the usual way.

You identity is hidden only for this call.

Which Account Is Used?

If you have more than one account enabled, Bria selects the account to use to place the call as follows:

« If adia plan exists for any account, Briaruns through the dial plansto determineif the dialed number
matches any of these plans. If amatch isfound, the acount that the dial plan belongstoisused. See“Dialing
Plan” on page 73.

» If thereisno match on any dial plans or if no dia plans are defined, then the default account is used.

When placing an outgoing call, you can explicitly specify the account to use for that call. Click the Account
Selection menu and select the desired account.

File View Contacts Actions

—_——
@ "Available ~ (5 1 missed
i .

- C-

Auto Account 9

Enter name or number Auto Aecount

Account 1
W Bccount 2
Options -

Once the call is placed, this menu always reverts back to “Auto”.

Ending a Call

Click End on the Call panel. Details of the call remain on the Call display. To clear the details of the call from
the display, click Clear.

12
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3.5 Handling an Incoming Call

Bria must be running to answer incoming calls. (If Briais not running, incoming calls may be directed to
voicemail, but check with your Vol P service provider to be sure.)

Briarings and information about the incoming call appears in the Call
entry field. In addition, the Call Alert box appears, evenif Briais

minimized. For information on call alerts, see “Preferences—Alerts & | Incoming call from
Sounds’ on page 43. Kokila [Softphone: kpereira]
The softphone address of the person calling you is displayed. The "' @
display name may also appear.

Action From the ... Description
Answer Call panel or Call Alert box |Click Answer.

If you are on another call, that first call is automatically put on hold. You are
now talking to the new caller.

Or press Enter (on the keyboard), if Briais the active application.

Decline Call panel or Call Alert box |Click Decline. There will be abusy signa. In some networks, the call will be
directed to voicemail (if you have this service).

Permanently Options menu Click the Options button and choose Block this person.

block the caller

Answer with IM | Options menu Click Options and choose Answer with Instant Message. The phone call is

declined, and instead an Instant M essage window appears. Type the message
and click Send. (Or close the window if you change your mind.)

Creating a Contact

If the caller is someone who is not currently in your contact list, the Add to Contacts button appears. You can
click this button at any time during the call and for up to three seconds after the call has ended.

Dizplay a= [Hau
Softphone E ;| kpereira
Groupis) Friends E —E"’E—
C_Ilck to display the Cor_ltact Prqflle P Cancel
dialog and enter more information _—_————— _—
—

Ending a Call
Click End on the Call panel. Details of the call remain on the Call display. To clear the Call display, click Clear.

13
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3.6 Handling an Established Call

Whilethe call isin progress you can:

«  Control the audio: use the speakerphone, mute the call, control volume.

* Record the call.

* Putthecal on hold.

e Addthecaller as acontact.

e Pull anindividua call into a separate panel. See the next page.

» Transfer the call. See the next page.

* Add video. Pause and resume video when video is aready present. See “Video” on page 17

Showr/hide video panel. See page 17
Conference call. See page 19

Hold

Place another call (this one will automatically be
put on hold). See page 11

Quick transfer. See page 15
Mute

Record on/off

Speakerphone (this button
only appears if your computer
has a speakerphone)

p 02 mqpg ™
Call establizhed

Add the current

caller as a Options -

contact Skart Yiden You can do any of these
P ——— Send Instant Message even with the call in

) progress. Many of these
Send Email. . actions are also buttons on

Contacts the Call toolbar.

N

& Friends

Start another Call

Transfer Mow
all then TransfFer

Kay Quick TransFer k
Kevin - Pending request
: Wiew Profile
Kokila View History
= Home

Block this Person

& Work
Frank - Pending request

%% COUNTERPATH

14
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Displaying Separate Panels for Calls

You can pull each individua call into a separate panel.

The active call is currently notin

a separate window.

. . Click to separate the active call
This call is in a separate

window. Click to move back to
the main window

File View Contacts Actions

4 "0On the phone -

_ moep (0@ 0-2 8«
V-2 8 «))

Call established

Call on hold kpereira

Rita [Softphone: rsantos]

| 00:01:50 _ (o
Options v]

Phone Book

47> COUNTERPATH

Transfering a Call

Quick Transfer

You can set up alist of phone numbers that calls can be transferred to. Then during acall, you can transfer to
any of these numbers by selecting from alist.

To set up the numbers:
1. Choose File > Preferences from the menu. Display the Transfer panel.

2. Enter as many numbers as you want. To enter a new number, click in an empty line. To remove an entry,
click in the line and del ete the number.

Set one of the numbers as the default and click OK.

To transfer acall, click the arrow on the Transfer button and click the number to transfer to. As soon as the
transfer is made (the other phone starts ringing), the call is disconnected at your end.

Quick Transfer

Actions

% "'On the phone

- e (0@ -2 B )

Call established
rsantos

15
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Basic (Unattended) Transfer — Transfer this Call

You can transfer acall to any number, then hang up as soon as you have entered the number.
1. Click Options > Transfer this Call. The LCD prompts for the number to transfer to.

2. Cadl thetarget (the person you are transfering the call to) by keying the number.

3. Click Transfer; the message Call Transfered Successfully appears.

Or click Cancel to continue the current call

File View Contacts Actions

[ —
¢4 "0On the phone ~

Transfer Kokila [Softphone: kpereira] to
Frank [Softphone: fchﬂn]
000222

Attended Transfer — Call then Transfer

You can first speak to the target (the person you are transfering the call to), then click Transfer to complete the
transfer.

1. Click Options > Call then Transfer. Thefirst call is put on hold and a New call tab appears
2. Cadl thetarget in any of the normal ways.
3. When you are ready, click Transfer; the message Call Transfered Successfully appears.

File View Contacts Actions Help

e —
% "On the phone -

i (0 (-8 0«

Click button below to transfer Kokila to

Frank [Softphone: fchan]
00:00:14

—~

— | Options '|

If the target does not want to take the call, simply end the call with that person. The first call istaken off hold.

16
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Video

File View  Contacts  Actions
Show/hide video ey W
panel
o @@ 04 =4
Call establizhed
| rsantos
Adding Video

Either you or the other party can add video at any time.

To add video, open the Video panel and click Start My Video. When you add video, the other party may (or may
not) start sending their video to you.

You can add video, even if you do not have a camera, in order to start receiving the other party’s video.

Other Party Adds Video

If the other party startstheir video, the Video panel automatically opens and the video is played. You can start
sending your own video, if desired (and assuming you have a camera) by clicking Start My Video.

Pausing and Resuming Video

If the Video panel is open and video existsin acal, the Start My Video and Stop My Video buttons appear, to
let you pause and resume video.

If you close the Video panel, your video will stop being sent; you can reopen the panel and click Start My Video
again.

Control video from the Call
panel or the Video panel

File View Contacts Actlions Help

_———— - -
¢4 "On the phone - (L! 3 missed

y |

s (@ (0 ¢~ % = « 3

Call established
Rita [Softphone: rsantos]
00:04:37

This button only appears when video panel
is open

Start My Video
Add to Contacts

17
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Voicemall

If your service includes voicemail, then when you have voicemail messages, the word “new” appears beside the
voicemail icon at the top of the phone. Click the icon to automatically connect to voicemail and listen to your

messages.

Voicemail icon

File View Contacts

[ —
& " Available -

18
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3.7 Conference Calls

Starting a Conference Call

You can create a conference call starting from one existing call:

1. Click the Conference icon. Bria enters “conference mode”’ and “Call a conference participant” appears on
the LCD.

2. Placethe second call in one of these ways:

* Right-click on a contact and choose Add to Conference Call.
*  Typeaname or number.
(Or to cancel the call, click the Cancel button.)

When the second callee answers, the call will automatically be added to the conference.
Or you can start a conference call using all the existing, separate calls:
1. Establish the cals. The calls can be incoming or outgoing, and one or more calls can include video.

2. Click Conference All.

Conference icon Enter phone number for new participant

N <)

Action=  Help

(ﬁ:} 3 missed

Call a'conference participant
Rita

Phone Book

4% COUNTERPATH

19
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Conference is now established

_ N <N x|

File  View Contacts  Actions Help

F, " On the phone B ({I} 3 missed
- |

w 0@ %
2 conference participants

Rita [
Kokila [Softphone: kpereira] D

| 00:26:57

Phone Book B s

28
47 COUNTERPATH

Managing the Conference

Adding More Participants
You can add more participants to an existing conference in any of these ways:

* Right-click on a contact and choose Add to Conference Call.

* From the tab that contains the conference, click the Conferenceicon. Place acall by typing a name or
number. When the callee answers, the call will automatically be added to the conference.

»  Place a separate outgoing call in the normal way (by clicking the New Call icon to display a new tab).
When the call is established, click Conference All. All existing separate calls will be brought into the
existing conference.

»  Accept one or moreincoming calls. A separate call will be established for each call. Click Conference All.
All existing separate calls will be brought into the existing conference.

Whenever you click Conference All, al current established calls are conferenced together; you cannot keep
any one call out of the conference.

Removing a Participant

To remove one call from the conference, right-click on that participant and choose Separate Call from
Conference. The call becomes a separate call.

Disbanding the Conference
To break the conference into separate calls, click Options > Disband Conference.

To hang up on everyone, click the End button.

Suspending the Conference

To suspend the conference, click the Hold button.

20
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Audio Controls
Adjusting Volume. Use the speaker adjustment to adjust volume of the sound you are hearing.

Mute. Click & on the dialpad to prevent the other parties from hearing you. The ¥ icon appears on the Call
display. When you mute, you may also want to stop video feed, if any.

Speakerphone. Click & on thedia pad to put the callers on the speaker phone. The # icon appears on the
Cdll display.

Video Conference Calls

e

-

[ stop my Video f Options ""|

Starting a Conference with Video

To start a conference with video, make sure that both the existing calls are video calls. Then click the
Conference button.

Adding Video to an Existing Conference Call
Choose Options > Start Group Video. Your video starts immediately.
Or open the Video panel and click Start my Video.

When you add video, the other party may (or may not) start sending their video to you. You can add video, even
if you do not have acamera, in order to start receiving the other party’s video.

How Video Is Shared

When you conference two calls together, video continues as it was before the conference call. For example, if
you were sharing video with one party, and only sending your video to another party, then that is how the video
will be handled when the conference call is created.

The conference host, serves asthe “funnel” for other video. Whatever the conference host is receiving will
automatically be sent to the other parties.
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Controlling Video

Once video has been added, it can be paused, resumed and stopped in the same way as on aregular conference
call, by the intitiator of the individua “leg” of the conference call.

The conference host does not have special control over the video, and can only add video on legs for which they
were the initiator.

However, if the conference host pauses or stops video, other participants will no longer receive video, because
the host is the video “funnel” as described above.
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3.8 Instant Messaging

I nstant messages are made using softphone address. Therefore, you can send or receive an instant message (IM)
to:

* Any contact who has a softphone address.
*  Any party who phoned you from a softphone address.
*  Any party whom you phoned using a softphone address.

Sending an IM

1. Thereare several waysto select the person to send an IM to.

From the Contactstabinthe |Right-click on the contact and choose Send Instant M essage. The contact must

Phone Book have a softphone address.
An active phone call The person in the active phone call. Choose Options > Send Instant Message.
A person on hold In the Current Calls bar, click the arrow next to this call and choose Options >

Send Instant Message.

From the History tab in the Right-click on the entry and choose Send I nstant M essage.
Phone Book

The Instant Message window appears. Or if another Instant Message session exists, anew tab is created for
thisIM session.

2. Typethe message. Include emoticons and formatting, as desired.

To insert areturn in the message, press Ctrl-Enter. (You can control the behavior of Enter and of Ctrl-Enter;
see “ Preferences — Application” on page 42.)

3. Press Send or Enter.

You can press Ctrl-F to search for text in the large message area.

A separate tab for each IM conversation.

The active conversation appears in bold.

2 Kokila é a | If a message comes in on a hidden tab, the tab flashes.
Click the button to close one conversation.

- — -l
Joseph: Hi Kokila Video Call

it s Click to perform one of these actions

Block this Person l for the active conversation.

EEEWE A = T

Message input area

Q
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Receiving an IM

When an IM isreceived, either the IM window or a Call Alert pops up. (To control which window appears, see
see " Preferences— Application” on page 42.)

If the IM window is already displayed with an IM session with ancther person, the message from the new
person appears in another tab in that window. (You can set up Bria so that each person has their own IM
window; see “Preferences— Application” on page 42.)

Sending a Broadcast IM

You can send an IM to several people at one time. A broadcast IM is not a conference IM.

» With abroadcast IM, each recipient can reply to the IM, but only you will see these replies; the other
recipients will not see these replies.

* With aconference IM, al parties see everyone's messages and the messages each party sends are seen by
everyone. Conference IM is currently not supported.

1. Select the parties from the Contacts tab in one or more of the following ways:

»  Select one or more contacts in the usual ways (using Shift-click or Ctrl-click).
»  Select one or more groups in the usual way.

2. Right-click and choose Send Broadcast Instant Message. The Send Instant Message to Group window
appears.

Cas stant Message ! m .
Shows the display names of all the selected contacts and

To [Kokila, Rita — the individual display names of all the contacts in any
———— selected groups. Contacts that do not have a softphone
address are not included in the list.

BEEOE aw = ‘10 =
|

3. Typethe message. Include emoticons and formatting, as desired.

To insert areturn in the message, press Ctrl-Enter. (You can control the behavior of Enter and of Ctrl-Enter;
see “ Preferences — Application” on page 42.)

4, Press Send or Enter. The IM is sent and the window closes.

A recipient may send you a response, which will be displayed to you in aregular Instant M essage window;
you will then bein aregular IM with that one party.

You can press Ctrl-F to search for text in the large message area.
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3.9 Emall

You can send an email to one or more contacts, or to all the contactsin a group.

Select the contact, contacts or group, right-click and choose Send Email. An email window opensin your
default email application, with the “to” line populated with all those contacts who have email addresses (in their
Contact Profiles).

3.10 The Deskbar

The Deskbar provides acompact GUI for performing many Briaactions. It is assumed that you will work in this
mode after you are quite familiar with Briaand its features.

Your availability Switches between Call
button and End button

Missed calls

Menu changes depending on whether
Entry field there is an entry in the entry field

Restore to main window
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4 Contacts, History and Availability

The Phone Book panel, which isdivided into three tabs, provides accessto key contact, call history, and contact
availability (presence) features.

4.1 Contacts Tab

Add a Contact

- Display all contacts
Hiztory

oY = Q Display only contacts who are set up for

Availability and who are currently online
& Friends

Frank
Kay
-, Kokila

g
[ﬂ.

Rita - Pending request The availability of others. See page 34.
& Home
& Work

Kewvin

5 Wayumi

The Contacts tab displays your contacts and lets you specify multiple contact methods for them, including:

»  Softphone address

*  Home phone number

*  Business phone number

»  Célphone number

»  Fax number (thisis provided for convenience; Bria does not have any fax capability).
* Email

You can identify one of these contacts as the primary contact method.

Contacts are typically organized into groups. Briaincludes built-in groups. “Friends’, “Home” and “Work”.
You can add more groups, as desired.
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Using Contacts

Call acontact To use the person’s primary number, double-click or drag the contact to the
Call display.
To choose the number to use, right-click and choose Call, then click the
desired number.

Call acontact and includevideo  Right-click the contact and choose Call with Video. The Video panel opens,
and call is placed. As soon as the other party answers, Bria starts sending
your video.

Email a contact who has an Right-click and choose Send Email.
email address

Send an IM to acontact who hasa Right-click and choose Instant Message.

softphone address

You can watch the contact’s See Table 1 on page 37 for the meaning of the availability icons.
availability, if the contact has a o ) . - -
softphone address See “Availability” on page 34 for information on obtaining availability

information.

Contact Flyout

Left-click on a contact to show the Contact flyout. This flyout shows all the contact methods set up for the
contact and has icons you can click to perform an action that is valid for that contact method.

Rita
i \. Softphone
- Instant meszage
Edit Profile ™ Home: 604 555 1234 Click an icon to perform the
action.
g Mobile: 604 555 3344
[ rzantoz@email. com

Finding a Contact

If the contact list islong, use the ©, field to filter the contacts that are displayed. To clear the filter and
redisplay all contacts, clear the [ field.
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Setting up Contacts

Adding a Contact

Click , or right-click a group and choose Add Contact to Group. The Contact Profile dialog box appears.

Rita |
| General Other

Contact name

First. | et ' wChange:.
Name Rita Santos
Reset

Dizplay az Rita

Group .Fri&nds More...
Contact methods
* Require one or more contact methods
Method NumberiAddress
ESuﬂphune @| rsantos@domainA.com P-r-i-nj-a-&r--c-qng-rﬁtngg-
=" Softphone: sm:rsantus@dum.@
Home
“‘Nork = @ ——— —— Ring tone )
= Default E @
Fax E @ Show this contact's availability
Emall =
Website [
=
LuDelste Save & Close |, Cancel |

Importing Contacts

You can populate the Bria contact list by importing from an external file. The new contacts will be added to the
existing contacts.

You can import a contact list from:

* A comma-separated file. Use this method to import from a Microsoft® Excel® file. You will first have to
set up thefile; see below.

* A Microsoft® Outlook® or Microsoft® Exchange contact list (a*.pst file).

* A vCardfile (*.vcf file). A vCard is an electronic business card that is often attached to an email.

1. From the main menu, click the Contacts menu and choose Import Contacts. The Import Contacts wizard
starts.

2. Assoon asyou click Finish on the wizard, the Contacts tab in Briais updated to show the imported entries.
Note that none of the entries are set up with availability turned on; in order to view availability of contacts,

you must modify the appropriate entries by changing the Show this contact’s Availability checkbox. See
above for details.

Setting up an Excel File for Import

1. Remove any introductory text or headings from the top of the file. (You can keep text at the end of thefile;
it will beignored during the import.)
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2. Insert ablank row asthe first row, then insert the headings that Briawill use to interpret the meaning of
each column. The columns can be in any order. The most popular headings are:

display-name
entry_id
given_name
surname
postal_address.

For acomplete list of headings, see “ Contact List Headings’ on page 79.

3. Savethefileas*.cov.

External Storage of the Contact List

Each time Briais started, the contact list is retrieved from the external storage. Each time a contact is added to
the contact list, it isimmediately copied to external storage.

Thelist is aways stored on the local computer. In addition, if you have access to aremote storage server, you
can configure Bria so that the contact list is also stored remotely using XCap or WebDAV.

To set up for remote storage, see “ Account Properties — Storage” on page 64.

Exporting Contacts

You can export a contact list to acomma-separated file, apst file or avcf file.

1. From the main menu, click the Contacts menu and choose Export Contacts. The Export Contacts wizard
starts.

2. When you click Next, the export starts. The result is:

For an Outlook export, the existing.pst file is updated to include the entries from the Bria contact list. If
Outlook is open, the entries immediately appear in the contact list.

All information in the Bria contact list is exported to Microsoft Outlook. Only information that can be
displayed in Outlook actually appearsin the Outlook Contacts window. Typically this means that all
softphone addresss are exported (and stored in custom fields) but not displayed in Outlook.

For other formats, a new file of the specified typeis created.
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Managing Contacts

Changing Contact Information

To change the information for a contact, right-click the contact and choose View Profile. The Contact Profile
dialog box appears, see page 29. Some of the changes you can make are:

» Change any contact details.

* Add, delete or change a contact method.

»  Change the primary contact method.

* Move acontact to another group by selecting a different group.

* Add an existing contact to more groups by selecting one or more extra groups.

»  Change the Show this contact’s availability checkbox to enable or disable availability information for this
contact. For information on availability, see page 34.

Moving or Deleting a Contact
» Todrag one or more contacts to a different group, select them and drag to the new group.
» To delete one or more contacts, select them, right-click, and choose Delete. The contacts are removed from

this group.
Adding, Deleting or Renaming Groups
Select any group, right-click, and choose the appropriate menu item.

You can only delete an empty group.

Field Description

Display name Required. Thisis the name that will appear in the Call display and the Call Alert when this
person phones you.

Group Either:
¢ Choose one group.
» Click More and select several groups. The new contact will be added to each group.

Contact Methods Enter as many contact methods as you want. Email and softphone entries must have the format
<name>@<domain>

Primary contact method Choose the desired method. This method will be used when you double-click or drag this
contact.

Ring tone Choose aring tone for this contact, or use the default. Click the arrow to play the currently

selected ring tone.

Show this contact’s availability | Click in order to obtain this contact’s availability and display it on the Contactslist. Thisfield is
only enabled when a softphone addressiis specified.

This contact will have an availability icon beside their name in the Contacts list. Initially this
icon will be gray, later its color will change to indicate the current availability.

For details on availability, see page 34.

Other fields Complete as desired.
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4.2 History Tab

Display all calls

Dialed calls
Missed calls

o, & [:; @ @ @ Received calls
_ Status Date
{Cf Frank 00:05:52 Today 07:13:55PM
Canceled outgoing {0 Kokia Diald  Today 07:32:08FM
{0 Kokila Dialed Today 07:22:45PK
Answered call (incoming (o Rita Missed Today 07:31:15PM
or outgoing) (= Rita 00:02:02  Today 07-21:46PM
{("1 Rita 00:25:08 Today 06:50:328PM
f& Rita 00:01:16  Today 05:49:23PM
Missed or blocked (e spammer Mizsed Today 07:48:33PM

incoming

Managing the Lists of Calls

You can right-click on an entry in alist to:

 Deletethecdl.
 Deleteadl entriesin thislist.

« Addto contacts. The Add a Contact dialog box appears. Complete the dialog box and press OK. For more
information on the fields, see “Managing Contacts’ on page 31.

Display as [SiHE
Softphone E ;| kpereira
Group(s} Friends E Hore...
gom Contact !nin Cancel

»  Block this person to control whether they can send you phone calls or instant messages, or see your online
availability. You can change these privacy settings at any time; see page 44.
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Phoning and Sending IM from a List

You can right-click on an entry in the Received or Dialed list to:

» Placeacall to this person, using the contact method that was used for this call. You can also double-click to
place acall.

» Placeacal to this person and add them to a conference call that isin progress. For more information on
conference calls, see “Conference Calls’ on page 19.

* Send an instant message, if the call was made with a softphone address. For details, see page 23.
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4.3 Availability

Availability refersto the ability to see whether a person is available or not: online, on phone, busy, and so on.
Your availability information is displayed below on the main menu. The availability of othersisdisplayedinthe
Contacts tab.

You can publish your availability to contacts who have softphone addresss, and you can set up Briato view the
availability of other contacts.

Availability of other people

Your availability

A
\ File View Contacts Actions
\

N Tene—
®, " Available -~

- C-

Enter name or number

Phone Book
Contacts

Sa G

N

& Friends

Kay
Kevin - Pending request
. Kokila
= Home
& Work
Frank - Pending request

4% COUNTERPATH

Sharing Availability

Watching others’ Availability

To be able to see the availability of another person, either add that person to Contacts with the “ Show this
contact’savailability” field checked, or modify the existing contact information so that thisfield is checked. For
more information, see page 31.

As soon as the person is set up in thisway in your Contacts, Bria sends them a notification request. The request
asks that you be able to see that person’s availability. If the person alows this request, then the icon beside their
name (in your Contacts) becomes color coded, so you can determine their availability.

Allowing Other Parties to See your Availability (Publishing your Availability)

Continuing from above, when the other person allows the notification request, your name is added to their
contact list. As soon as you are added to their list, arequest is sent back to you requesting that they be able to
see you. You can reply to this request to complete the sharing loop.
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Troubleshooting: When You Cannot See Availability

If you have multiple accounts set up, icons may remain gray when you expect them to be color coded. For
information on how this can happen, see “ Account Properties — Presence” on page 62.

The following chart illustrates how the sharing of availability occurs.

Joseph Kokila

Joseph adds Kokila to his contact
list with “Show this contact’s
Availability” checked

Availability icon is added

for Kokila, colored gray Joseph's eyeBeam sends a “let me see you” o

notification request to Kokila
| Kokila receives a notification
request and responds by clicking

“Allow and add”

Joseph is added to Kokila's
contact list

Privacy rule is created for
Joseph with “allow” and “show”
Availability icon is added

for Joseph, colored gray

-t “Allow” response sent

Kokila's availability icon

turns green il
Now that Joseph is in Kokila’s contact list, Kokila's

T eyeBeam sends “Let me see you™ notification request to Joseph

Joseph receives a notification
request and responds
“Allow”

Response sent————————————P»
Joseph’s availability icon
turns green T

Receiving a Presence Request

Your Briareceives anew contact request when you add a contact to your list (with “Show this contact’s
Availability” checked) or when another person adds you as a contact at their end.

The request is handled in one of two ways:

» If you set up aprivacy rule before this person has a chance to contact you, then you will never see this
request. Briawill automatically reply to the request according to the rule. See “ Preferences — Privacy” on
page 44.

« If youdo not yet have aprivacy rule set up for this person or for their domain, this request appearsto you as
a Presence Request. You must respond to the request.

leques
Kokila (kpereira) would like to =ee your status when you are online.

Selecting 'Block' will prevent this person from communicating with you.

Allow and Add to Contacts { low Block
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Button

Next Action

Result

Allow and Add to
Contacts

This button appears only if the other personis
not already on your contact list.

When you click this button, the Add a Contact
dialog box appears. Complete the dialog box
and press OK. For more information on the
fields, see “Managing Contacts’ on page 31.

The other person will:
* Beableto see your availability.
« Be added to your Contacts.

In the future, you will not receive this request from this
person.

In addition, this same request will be sent to the other person,
so that you can see their availability.

Allow The other person will:
« Beableto see your availability, but for this session only.
Because you have not set up the person as a contact, a
Presence Reguest will appear for this person each time you
start Bria

Block The other person will:

« Not be ableto see your availability.
« Not be ableto phone or IM you.

« Beadded to your Blocked List. See “ Preferences—
Privacy” on page 44.

Close the window

The other person will not be able to see your availability. The
other person will not be added to your privacy settings.

The Presence Request may appear again in this session or a
future session

For important information on how privacy affects availability, see “Privacy” on page 39.
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Setting your Availability

Changing your Availability

Click the down arrow beside the availability indicator on Bria, and select the desired availability. See Table 1,

below.

Fie  Wiew

Contactz Actionz

e
*, " Available -

v Available

Busy
Awmay

on the phane

Mot available For calls
Do nok diskurb
OFfline

Cuskom Skaktus Message. ..

When your availability changes, the new availability is sent to everyone who has permission to see your
availability, according to the Privacy Settings (see “ Preferences — Privacy” on page 44).

Setting up Availability Indicators

You can create custom availability indicators, or edit or delete custom or built-in indicators: click the down
arrow beside the availability indicator, and choose Custom M essage.

Table 1: Availability Indicators

Indicator

Meaning for your Availability

Meaning for Others’ Availability

Available

Either:

* You have set your availability to this status.

< Briahas determined that you are logged on but not on the
phone or idle.

When you have this availability, Briawill automatically detect
when you areidle or on the phone, and change the availability to
match.

You can contact this person.

Busy

You have set your availability to this status. Briawill never
automatically switch you out of this status; you must switch
yourself.

You can contact this person.

On the phone

Either:

* You have set your availability to this status. In this case, Bria
will never automatically switch you out of this status; you
must switch yourself.

« Briahas detected that you are on acall. When your call
finishes, your availability revertsto the last availability.

You can contact this person.

Not Available
for calls

You have set your availability to this status. Briawill never
automatically switch you out of this status; you must switch
yourself.

Incoming phone calls will be directed to voicemail.

Your phone calls to this person will be
directed to voicemail.

You can IM this person.
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Table 1: Availability Indicators

Indicator

Meaning for your Availability

Meaning for Others’ Availability

Do not disturb

You have set your availability to this status. Briawill never
automatically switch you out of this status; you must switch
yourself.

Both incoming phone calls and incoming IMswill be directed to
voicemail.

However, you can still make phone calls and IMs. When the
other person responds, your availability will remain as Do not
disturb.

You cannot make phone calls or IMsto this
person.

Idle

You have not moved or clicked the mouse or pressed a keyboard
key for the Idle period. To set the Idle period see “ Preferences —
Application” on page 42.

As soon as you click the mouse or keyboard, your status changes
to Available.

You can contact this person.

Away

You have set your availability to this status. Briawill never
automatically switch you out of this status; you must switch
yourself.

You can contact this person.

Offline

Not applicable

The contact is either not logged on or elseis
not set up for availability.
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4.4 Privacy

You can control how contacts and other people can contact you by phone or IM, and you can control whether
your contacts can see your availability information (whether you are online, one the phone, and so on).

You can set up controlsin advance or “on the fly” (as phone calls and presence requests come in)

Setting up Controls in Advance

To set up controlsin advance, see “Preferences — Privacy” on page 44.

Setting up Controls “on the Fly”

On an Incoming Call

To block someone when they are phoning you, choose Options > Block this Person.

el

File View Contacts Actionz Help

1
« "Available - (& 1 missed
= .

Incoming call
Spammer

Decline - Options -
G)

Transfer Mow
uick Transfer r

4% COUNTERPATH

Block this Person

The call is declined, and this person is added to your Blocked List (see page 44). In addition, if the personisa
contact, then “blocked” appears beside their name in the contact list.

You will no longer seeincoming calls or instant messages from this person; they will automatically be declined.

To later unblock this person, remove them from your Blocked List. Or, if the person is a contact, right-click
their name on the contact list and choose Unblock this Person.

39



CounterPath Solutions, Inc.

On an Incoming IM

To block who sends an IM, choose Options > Block this Person on the Instant Message window. Then close the
window.

2 spammer e O

Call
Yideo Call

spammer: hello
Yiew Profile

Elock this Person

CERUE~ @ o

Last message received: 08/25/07 17:36:18FM

The other person gets a message that their instant message has been declined.

This person is added to your Blocked List (see page 44). In addition, if the person is a contact, then “blocked”
appears beside their name in the contact list.

You will no longer seeincoming calls or instant messages from this person; they will automatically be declined.

To later unblock this person, remove them from your Blocked List. Or, if the person is a contact, right-click
their name on the contact list and choose Unblock this Person.

Via the Presence Request Dialog Box

Another party can send you a presence request, to request that they be able to see your availability, as described
on page 34.

Your response has the following effect on privacy:

» If you add the person as a contact, then the ability of that person to phone or IM you is controlled by your
privacy settings; see “ Preferences — Privacy” on page 44.

« If you alow the person without adding them as a contact, then the ability of that person to phone or IM you
is controlled by your privacy settings; see “ Preferences — Privacy” on page 44.

« If you block the person, then that person is added to your Blocked List (see page 44). The person will not be
able to phone or IM you, and will not see your availability information. You can change this blocking by
removing the person from the Blocked List, in which case they will then be controlled by your privacy
settings.

From the Contact List or History List

Right-click on the name and choose Block this Person. The person will be added to your Blocked List (see
page 44). The person will not be able to phone or IM you, and will not see your availability information.

To later unblock this person, right-click on the name and choose Unblock this Person
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5 Configuring Bria

You can configure Briain several ways.

e Set up your personal profile. See below.
» Configure global behavior. See “ Configuring Preferences’ on page 42.
»  Configure the behavior on a per-account basis. See “Configuring Accounts’ on page 55.

5.1 Configuring your Profile

First Last .
Mame Joseph Santos Company
Dizplay a=  Joseph Santos Title:
Account Joseph e oo B
Contact methods Addresses
Method NumberiAddress Home | Work | Other
ESuﬂphune a| jsantus@dumainﬁx.curﬂ I
Home
Waork E
lobile =
Fax E
Email =
Website Notes

To set up information about yourself, choose File > My Profile. In later versions of Bria, you will be ableto

share this information with other users.
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5.2 Configuring Preferences

Choose File > Preferences. The Preferences window appears.

The Preferences panels let you control the way that you work with Bria

Preferences — Application

M @& Auto launch when Windows starts

wa Open new mezzages as zeparate windows rather than tabs

i RLACY s
&% Callimmediately once a phone number is zelected
i sfer
- = In messaging, pressing 'Enter” will
DO ey

@ Send the me=sage (Use Cirl + Enter to create a line)
% O Create a new line (Use Cirl + Enter to send)

. Winutes before status automatically changes to idle after no activity
io ] —
10

Reset to Default | ) OK JI Cancel

This panel lets you set your preferences for general GUI behavior.
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Preferences — Alerts & Sounds

Application Alerts & Sounds

s Mute all sounds

Select an event: | Incoming call E
Incoming call
uick sfer Play Sound: Default (Incoming call) E Play Delete

wlDPACLSoUNdS

& Show alert box  when phone is not in focus [

Network,
dio ac:
Video Codecs
Quality of Service
Diagnostics

——fidvanced .,

Reset to Default | OK | Cancel |

This panel lets you assign sounds and lets you control the Call Alerts box.

Assigning Sounds

You can assign specific soundsto avariety of actions or “events’. For each, you can assign the default ringtone,
which is different for each event. In other words, the default ringtone for an incoming call is not identical to the
default ringtone for call waiting.

This panel lets you set up default ringtones — the tones that will be used if specific tones are not assigned. For
example, if it isthe ringtone that will be used for incoming calls unless you assign a specific ringtone to a
specific contact (see page 29).

If you import sounds, these will be added to the list of sounds you can choose from when assigning a sound to
an action.

Showing Call Alert Box

You can control whether the Call Alert box is displayed for an
incoming call or IM.

Incoming call from
Kokila [Softphone: kpereira)

o @
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Preferences — Privacy

You can control how contacts and other people can contact you by phone or IM, and you can control whether
your contacts can see your availability information (whether you are online, on the phone, and so on).

Privacy

General Curporag

Global Contact Settings: {Instant Messaging and Softphone)

@ Allow everybody to contact me (except those in my block lists)
OAIIuw only those people on my contact list to contact me

Blocked:

Enter a number or address:

Block
[ unblocic |

Enter a domain: (eg., counterpath.com}
il .
wbnbloche,

spammermdo maind,

When a person or domain is blocked, you will block all calls, messages, and requests
to see you online.

O] Cancel

Reset to Default |

Privacy

“General Corporate

People in the following domainz are automatically allowed to 2ee your online statuz when
they add you to their contact lists.

Allowed Domains:
Domain Name Contacts Added to

AcmeAceEnterprises.com Work

Choose one.

If you choose “Allow only”, then all
contacts will be able to contact you
unless they or their domain are in
the Blocked list (below).

This section is optional. It lets you
enter addresses and domains that
will be prevented contacting you.
You can add and remove entries
from the blocked lists.

In addition, entries are automatically
added to this list when you block
someone “on the fly” (page 39).

If you enter a domain in this list,
people in that domain will
automatically be allowed to see your
availability online.

You will no longer see Presence
Request dialogs from these people in
this domain.
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Preferences — Quick Transfer

Application

@& Auto launch when Windows starts
s Open new messages as separate windows rather than tabs

@ Callimmediately once a phone number is =elected

In messaging, pressing 'Enter” will

@ Send the me=sage (Use Cirl + Enter to create a line)
_&M— O Create a new line (Use Ctrl + Enter to send)

Minutes before status automatically changes to idle after no activity

10

wmBesstio Detauit,, | e | e RO |

This panel lets you set up alist of phone numbers that calls can be transferred to. Then during a call, you can
transfer to any of these numbers by selecting from alist.

Enter as many numbers as you want. To enter anew number, click in an empty line. To remove an entry, click in
the line and delete the number. Set one of the numbers as the defaullt.

See “Quick Transfer” on page 15 for information on using this feature.
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Preferences — Devices

Application Devices

\uAlerts & Sounds, fient tide

Speaker piantronics Headset E
Microphone  piantronics Headset
Speakerphone Mode
m Speaker  =oundMAX Digital Audio =
Wicrophone | ggitech Microphone (Zoom) E
@& Reduce background noise
wadudioCodecs .y

Phone Ring Device
LuVideo Codecs Ring device  gpundmAX Digital Audio =]
Ring volume E]

W Alzo ring PC speaker (note: no volume control)
i -
Camera
i DOVANCET Camera: | ggitech QuickCam Zoom =
iuResetto Default | J u| s Cancel

Bria automatically detects devices at each startup, and selects the most appropriate device for each purpose. I
you do not like this selection, you can override it on this panel.

If you override a selection, it will be honored the next time you start Bria, unless the device is no longer
available, in which case Briawill again select the device to use.
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Field

Description

Headset Mode

Speaker
Microphone

Change these fields only if you want to override the devices that Bria
automatically selected.

In both these fields, select the headset you are using.

The headset is the device that is usually used for audio out (the sound you hear)
and audio in (recording your voice). The only situation in which the headset is
not used is when the Speaker Phone button on the dialpad is pressed.

Therefore, unless you will always be using Briain speakerphone mode, you
must make a selection here.

Select the headset in both the Speaker device field and Microphone devicefield.

Speakerphone Mode

Speaker

Change thisfield only if you want to override the devices that Bria
automatically selected.

Make the appropriate choice:

» Select the device that you want to use for audio out (the sound you hear)
when the Speaker Phone button is pressed. Make sure you select a speaker
device (not the headset).

» Select Noneif you do not have a speaker phone. The Speaker Phone button
on the dialpad is disabled.

Microphone

Change thisfield only if you want to override the devices that Bria
automatically selected.

Make the appropriate choice:
 Select the device that you want to use for audio in (recording your voice)
when the Speaker Phone button is pressed.

It can be any microphone: it does not have to be the microphone on the
device you specified as the speaker device. For example, it can be the
microphone on your camera.

» Select Noneif you do not have a speaker phone. The Speaker Phone button
on the dialpad is disabled.

Reduce background noise

Automatically attempts to remove background noise.
Typically on for the speakerphone.

Phone Ring Device

Ring Device Changethisfield only if you want to override the devices that Bria
automatically selected.
The device where you want to hear the phone ringing: the headset, the
speakerphone, or none.

Ring volume The volume of the ringer.

Also ring PC speaker

Click on or off, to suit your preference.

Camera

Camera

Changethisfield only if you want to override the devices that Bria
automatically selected.

Select the cameramodel.

47




CounterPath Solutions, Inc.

Preferences — Network

licati Network
Alerts & Sounds Network Connection Speed
s Use automatic bandwidth detection
% ODiaI—up or ISON
(@) Cable, DSL or ADSL
f
ule i (Q) Fast cable, DSL or ADSL
- @Lucalarea network (LAN)
%
w Preserve bandwidth during silence periods
diu ac:
walfiden Codecs
uali ice
0stics
e AANCED
Reset to Default | OK J Cancel I
Field Description

Use automatic bandwidth detection.

Click the box to let Bria detect the speed of your network connection and hence
the potential bandwidth. If you move your computer to a different | P address,
Bria automatically detects the new speed.

Or select the type of network connection for your computer.

Preserve bandwidth

When this feature is on, Bria stops sending audio when you are not talking.

When this feature is off, Bria always sends audio, which uses more bandwidth
but may result in better call quality.

Typically off. However, if you are using a slow (dial-up or ISDN) connection,
you may want to turn it on.
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Preferences — Audio Codecs

égg“““gg Audio Codecs

Disabled Codecs Enabled Codecs
erls & nds
Speex G711 uLaw
- Speex FEC G711 aLaw
] DG
_>
_— Speex Wideband FEC
uick sfer i
BroadWoice-32
r-
_ BroadWoics-32 FEC
ices
%
ideo Code
Codec Properties

— BE' Hosliu Description:

Bitrate range (bps):
M— ideli
Fidelity:

BestQuality (PESQ): [ |

0.0 4.5

Reset to Default ! __.%_l s cancel !

This pane shows all the codecs that are included in the retail version of Bria. You can enable or disable codecs
as desired.

With only one codec enabled, all calls made will use that codec. With more than one codec enabled, Bria
automatically chooses the best codec based on the other party’s capability, the available bandwidth, and
network conditions.

You cannot change the properties of any codecs.

About Codecs

Audio codecs describe the format by which audio streams are compressed for transmission over networks.
Codecs can be categorized as either narrowband or wideband:

» Narrowband codecs work with low bandwidth such as a dialup internet connection. These codecs have a
sampling rate of 8 KHz.

*  Wideband codecs work with high bandwidths and result in better audio quality. However, they do not work
with PSTN. These codecs have a sampling rate of 16 KHz.
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Supported Codecs

Bria supports awide range of codecs. See the table.

Codec

Narrowband

Wideband

Royalty-bearing

Included in
Retail Bria

AMR Wideband (G722.2)

v

Broadvoice-32

Broadvoice-32 FEC

DVi4

DVI4 Wideband

< <] <<

EVRC

G71lalaw *

G71luLaw *

G722

G723

NINERERE

G726

G729*

GSM

iLBC

L16 PCM Wideband

Speex

Speex FEC

N EENEEN EENEEN IEN

Speex Wideband

Speex Wideband FEC

NINEEREERERERE

* Generally, at least one of these codecs must be enabled in order to place a PSTN (land line) call.
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Preferences — Video Codecs

Quality of Service

BE HOE“:E

u—ianced .,

Reset to Default |

Video Codecs

Disabled Codecs

Codec Properties

Description:

Enabled Codecs

H.263

H.263+ (1998)

CPU usage: |

Quality: [

High

OK |

——

Cancel '

This pane appears only on versions of Bria that include video functionality.

Video codecs describe the format by which video streams are compressed for transmission over networks.

Some codecs require less bandwidth than others, but may result in lower video quality.

You can enable or disable codecs as desired. You may decide to disable a codec even though your service

provider supportsit.

With only one codec enabled, all calls made will use that particular compression format. With more than one
codec enabled, Bria automatically chooses the best codec based on the other party’s capability, the available
bandwidth, and network conditions.

You cannot change the properties of any codecs.

Supported Codecs

Codec Narrowband Wideband Royalty-bearing lgglt:ﬁ?rii‘:
H.263 v
H.263+ 1998
H.264 v
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Preferences — Quality of Service

Application Quality of Service
Audio QoS
erts & nds. @ None
(@ Use DSCP/ TOS value [1..63]
LAY ey : ' —
OUSE Service Type: Best Effort
. —— when available
ices Video QoS
@non= B These fields appear only on versions ¢
Hetwork, @ Use DSCP/TOS value [1...63]: Bria that include video.
@ Use Service Type: =
Audio Codecs
Signaling QoS
Video Codecs @ tione
O Use DSCP/TOS value [1..63]:
| Diagnostics
Advanced
Reset to Default | OK. . Cancel |

The Quality of Service pane lets you request a specific transport service for audio, video and signaling traffic.
There are two types of services. The service to use depends on what your internet service provider supports:

e GQoS, which isavailable for audio and video.
» DSCP (aso known as ToS), which is available for audio, video and signaing.

In anetwork that has the default configuration, the recommended value for audio is 46, because “46” isthe
standard marking for audio.

In addition, if you are running Briaon Windows on an Intel® Centrino® Duo mobile-technol ogy-based laptop,
you can request to reserve bandwidth for audio traffic on wireless networks using 802.11e. If bandwidth is
available when the call is placed, it will be reserved for the call, possibly resulting in better audio service.

Bria supports 802.1p QoS packet tagging. If you set up for QoS, Briawill include the specified information in
the packets that it sends to the network provider. Whether the packet is delivered with the specified service
depends on whether your broadband router and the network provider between you and the other party supports
multiple transport services. In other words, whether each network provider reads the QoS information and
prioritizes packet delivery based on the requested service.
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Preferences — Diagnostics

Application Diagnostics

erts & nds. wa Enable diagnostic legging
Content to Log
%
Diagnostic log levels for components
uick sfer Al components
imal
ices
%
Audio Codecs
Video Codecs
Quality of Sarvice e e e

e

Diagnostic log output ™~ e e~y

Advanced
Open Diagnostic Folder Send Diagnostic Logs...
Reset to Default | OK I Cancel |

This pandl lets you enablelogging to files. Logging uses computer resources, so you should only enable it when
instructed by a customer support representative.

To set up logging:

1. Click Enable diagnostic logging. If instructed, clear the Simple View box to show the complex view.
2. Setthelogging level.

3. Specify the folder where logs will be saved.

4. Click OK.

Activity on Briawill belogged to.csv filesin the specified folder. A new set of filesis started each time you log
on. In order not to create large files when logging (which may create computer problems), you must not remain
logged on indefinitely when logging. You should occasionally exit and restart Bria.

If requested by a customer support representative, you can:

*  Open thelogging folder and then open alog file using a text editor.

« Email thelogsin the specified folder to customer support: Click Send logs to customer support. A dialog
box appears showing all the logs. Select files and click Open; the selected files are sent and the dialog box
closes.

You can delete log files from the specified folder as you would delete any file on your computer.

53



CounterPath Solutions, Inc.

Preferences — Advanced

licati Advanced

M &% Reduce echos from speakers (AEC)

@4 Use slower but more compatible video format

wmBesstio Detauit,, | e | e RO |

This screen lets you set advanced features:

*  Reduces echos. Turning this feature on improves sound quality. This feature is typically on.

»  User slower but more compatible video format. Turning this field on may improve performance when
runing the application on older hardware.
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5.3 Configuring Accounts

Choose File > Account Settings. The SIP Accounts window appears.

SIP Accounts

To work with accounts, choose File > Account Settings from the menu. The SIP Account window appears,
showing all the accounts set up. Each account is automatically assigned a number: the first account in thelist is
0, the second account is 1, and so on. These numbers do not imply any ranking.

SIPaccomts x|

Enabled | Account | Domain | Lsername | Display Name | Edit. . |
W laccounet JEPPE | [ |

Account 2 Emply MMake Defaulk |
Account 3 Emply

Account 4 Emply

Account S Emply

Bccount & Emnpky

Account 7 Emnpky

Account 5 Emnpky

Account® | Emply

Account 10 Emply

OOoOoOooooon

Close

You can:

e Add or remove an account.
* Enable one or more accounts. See below for details.
*  Set one account as the default. See below for details.

»  Set or change the properties of an account. These properties control how Briainteracts with your VolP
service provider, and are set individually for each account. Click the Properties button, then see the
following pages for details.

Enabling Accounts

You must enable an account in order to make and receive calls on that account. You can enable as many
accounts as you want. Click the Enable box beside each account. The rules for enabled accounts are:

*  When multiple accounts are enabled, you will be able to receive calls on al those accounts.

* You can never place acall on adisabled account. If you place acall that is only “known” to the service
provider of adisabled account, it will fail with a“Not found” message.

* You can never receive a call on a disabled account. If another party phones you on a number that is only
known to a disabled account, the call will never appear on your Multimedia Communicator.

»  When multiple accounts are enabled, the account to use for an outgoing call is determined by the rules of
the dial plan determine which account is used. See “Dialing Plan” on page 73. If you have not set up any
dial plans, then the default account is used.

Setting the Default Account

When multiple accounts are enabled, one account is always the default. You can set any account as the default
account: click on the account and click the Make Default button.

The dial plan rules may select the default account to use to place an outgoing call, as described on page 73.
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Account Properties — Account

Account 1 Properties

Account |Voicemaill Topolog_l,ll Securit_l,ll .t‘-\dvancedl

Account I Account 1

X

—User Details
Display Name I Jaseph
Username I jsantos
Password I
Authorization user name I
Damain

I domaina.com

—Domain Procy
I Reqister with domain and receive incoming calls

Send outbound via:
" domain

 prosy address I

% target domain

—35IP Listen Port

I 2456

[~ Manual override

Dialling plan I
(] I Cahcel | Apply |
Table 2: Account Properties — Account
Field Description

Account I desired, change the account name to something that is meaningful to you. For
example, the name of the Vol P service provider.

User Details

Display name Thisnameis displayed in the Briadisplay.

Other parties will see this name they are when connnected to you.

User name Typically the account number for the softphone account. For example, in
kpereira@domain.com, the user nameis “kpereira’. Provided by your Vol P
service provider.

Password Provided by the service provider.

Authorization user name

May not be required. If it isrequired, it will be provided by your Vol P service
provider.

Domain

For example, in kpereira@domain.com, the domain is “domain.com”. Provided
by your Vol P service provider.

Domain Proxy

Register with domain and receive incoming
cals

Check this box if you want to register with your VoIP service provider, so that
you can receive incoming calls.

Typically, this field is checked.

A situation in which thisfield is unchecked is, for example, if your level of
service does not include the ability to receive incoming calls. Inthis case, turning
this field on may cause registration to fail (when you close the Account
Properties window), meaning that your Bria cannot register with your Vol P
service provider.
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Table 2: Account Properties — Account

Field Description

Send outbound via Choose the setting specified by your VoIP service provider:

« Domain: If your VoIP service provider requires that traffic be directed to
proxies that are discovered via the domain.

« Proxy: If your Vol P service provider has an outbound proxy address and
reguires that you provide the address to Bria. For the address enter adomain
name (for example, domain.com) or an IP address (for example,
123.456.789.012).

e Target domain: To send directly to the other party’s domain.

Dialing Plan Information about the syntax of the numbers used by this Vol P service provider.
Provided by the service provider. The default planis:
#1\a\a.T;match=1; prestrip=2;

It is possible that this plan will work for you. If you can place a successful call,
then the dialing plan is suitable. If you cannot make acall, or if you want to set
up adialing plan for you own reasons, see “Dialing Plan” on page 73.
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Account Properties — Voicemail
x|

Account  Yoicemall I Topolog_l,ll F'resencel Storagel Securityl Advancedl

¥ Check For voice mail

Murnber to dial For checking voicemail I

Mumber For sending calls to voicemail I

[ send calls ta voicemail if unanswered For ID seconds

Forwarding

[ always Farward to this address I

™ Forward ko this address when busy I

0K I Cancel | Apply |

Complete these settings only if your service provider offers voicemail.
These settings | et you set up Briato forward calsin severa situations.

Your service provider may also provide the ability to set up for voicemail outside of Bria, for example, by
phoning a softphone address and following the voice prompts, or by accessing a website.

Check with your service provider to determine if another setup mechanism is available. If so, check what the
settings arein that setup, and make sure you do enter compatible information in Bria. In particular, if your
service provider has a mechanism for call forwarding, find out if you should leave the Forwarding settings on

this Voicemail tab blank.

Table 3: Account Properties — Voicemail

Field

Description

Check for voicemail

I your VOIP service includes voicemail, choose the setting specified by your
VoIP service provider:

« On: Briawill subscribe to be notified when there is a voicemail for you.

« Off: the service provider may be set up to advise Briawhen thereisa
voicemail for you; check with your service provider for details.

If your Vol P service does not include voicemail, choose Off.

Voicemail is controlled by your Vol P service provider, not by Bria. Contact your
service provider for information on using voicemail.

Number to dial for checking voicemail

Complete only if your VoI P service includes voicemail.

If you leave thisfield empty, then thisicon will not work; you will have to
manually dial this number in order to connect to voicemail.

Enter the number provided by your Vol P service provider.
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Table 3: Account Properties — Voicemail

Field Description

Number for sending calsto voicemall Complete only if your VoIP service includes voicemail.

Thisis the number that incoming calls will be forwarded to if they are
unanswered after the specified interval (below).

If you leave thisfield empty, then thisicon will not be displayed. However,
leaving this field does not mean that voicemail does not work. It only means that
thisicon cannot be used to send to voicemail immediately.

Enter the number provided by your Vol P service provider.

Send callsto voicemail if unanswered Complete only if your VoI P service includes voicemail.
To send to voicemail after the specified number of seconds.

Your service provider may also provide asimilar feature that is set up outside of
Bria. If so, make sure you do not enter competing information in Briaand in the
service provider’s user interface. For example, if you turn off thisfield, make
sure the same feature at your service provider is aso turned off. Otherwise, all
your callswill continue to be forwarded.

Always forward to this address Not currently supported.

Forward to this address when busy Not currently supported.
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Account Properties — Topology

.-’-‘«ccountl Yoicemail  Topology |F'resence| Storagel Securityl Advancedl

]

rFirewall Trawversal
IF address
' Discover global address
" Use local IF address
STUM server

% Discover server

" Use specified server:

v Enable ICE

—Port used on lacal computer
[ Manually specify port range

Starting part murmbers I a
Ending pork number: I a
0K I Cancel Apply |
Table 4: Account Properties — Topology
Field | Description

Firewall Traversal

IP Address

This setting controls how your IP addressiis presented.

« Discover global address: Let Briadetermine your public IP address. Thisis
the recommended setting unless your Vol P service provider advises
otherwise.

e Uselocal IP address: use the | P address of the Bria compulter.
The recommended setting is Discover global address.

STUN Server

This setting specifies the STUN server to use.

» Discover the server: Choose thisoption to let Briafind the address of a STUN
Server.

e Use specified server: To use adifferent STUN server. For the address enter a
domain name or an | P address.

The recommended setting is Discover server.

Enable ICE

ICE optimizes traffic and may help with firewall traversal.

Typically, ICE is enabled. However, it may need to be disabled if your Vol P
service provider has implemented afirewall traversal solution that is not
compatible with | CE enabled.

If you have problems with calls, contact your service provider for information on
their firewall traversal solution.

Port Used on Local Computer

Manually specify range

The appropriate setting depends on your computer setup:

e Checked: If your computer is behind arestrictive firewall that only allows
specific port ranges to be used. Enter the range of portsto use for your SIP
account. (You must also open those ports on your firewall; refer to applicable
firewall documentation for information.)

« Unchecked: If your computer is not behind arestrictive firewall.
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Account Properties — Presence
x|

.-’-‘«ccountl Voicemaill Topology  Presence I Storagel Securityl Advancedl

Mode!

Pall Eime I 300 seCamds

Refresh interwal I 3600 secands

0K I Cancel | Lpply |

Presence allows other softphone users to see your online availability, and also allows you to seethe online
availability of others.

Table 5: Account Properties — Presence

Field Description

Presence Mode Choose the setting specified by your VOIP service provider:
« Disabled: Presenceis not supported.
* Presence Agent.

*  Peer-to-Peer.

Poll Time Enter the value specified by your VoI P service provider. The factory setting is
300.

Refresh Interval Enter the value specified by your VoI P service provider. The factory setting is
3600.

How Availability Works for Single Accounts

If you have only one account, enter the appropriate values on this tab, in order to configure Bria according to
how presence is supported by the Vol P service provider.

The iconsin the Contacts tab on the Calls & Contacts drawer will be color-coded to show the contacts
availability.

Once you have configured presence on this page, you can set up rules; see“ Availability” on page 34 and
“Preferences — Privacy” on page 44.

How Availability Works for Multiple Accounts
The Presence tab appears only for the account that is currently the default account. If you change the default
account, the Presence tab will appear for that account and not for the previous default account.

The tab only appears for the default account because typically you can only see the presence for contacts who
are contacted through the proxy for the account that is currently the default. For example, when the account
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domain.com is the default, al the contacts with the address “ @domain.com” are watchable. The contacts at
other domains are not watchable; their availability icons appear as gray.

(The only exception to thisruleisif the default account supports “ passthrough”, in which case you will be able
to watch contacts for domains that the service provider passes through. Contact your VoIP service provider for
details.)

The procedure for configuring availability for multiple accountsis:

» Choose which account you want to watch availability on. Set that account as the default. Note that the choice
of default will affect how your dia planswork (if you use dial plans). See “Dialing Plan” on page 73.
» Enter the appropriate values on the Presence tab for that account.

Theicons of the eligible contacts in the Contacts tab on the Calls & Contacts drawer will be color-coded to
show the contacts’ availability.
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Account Properties — Storage
x|

.-’-‘«ccountl Voicemaill Topolog_l,ll Presence Storage ISecurit_l.Jl Advancedl

Storage methaod =

[FServer Sethings
¥ se 5TR credentials

Usermarme I
Password I

Root LURL I https:ffwebday, $domaindfwebdasw $username

WebbaY poll Eime &00 seconds

0K I Cancel | Lpply |

These settings et you set up aremote storage system for your contact list viaWebDAV or XCAP. (The contact
list is always stored locally, even when you set up for remote storage.)

The tab only appears for the current default account: see below for an explanation.

How Storage Works for a Single Account
If you have only one account, all three storage methods are supported and easily managed.

How Storage Works for Multiple Accounts

If you have multiple accounts, the local storage method is supported and easily managed.

However, if you are thinking of setting up remote storage, keep the following in mind: When you add a contact
(either manually or through a new contact notification), the contact is stored at the remote storage location for
the current default account. Keep in mind that this account may not allow the new contact’s availability to be
watched (for an explanation see “ Account Properties — Presence” on page 62). In addition, when you switch
default accounts, the list of contacts displayed on the Contacts tab switches from the old default account to the
new default account.
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Field Description

Storage method The storage method to be used for the Contactsist file and the presence rules.
Thefile can be stored locally or on aremote computer.

e Local only
¢ WebDAV and local
¢ XCAPandloca

Use SIP credentials Check thisbox to use the username and password from your SIP account in order
to log into the storage server.

Otherwise, uncheck this box and complete the Username and Password fields.
Not used for “Local”.

Root URL URL of an appropriate root folder on the remote server.
Not used for “Local”. The factory setting is https://webdav.$domain$/webdav/
$username$/

WebDAV poll time Enabled only for WebDAV. The time that elapses between polling for new

contact data from the remote server.
The factory setting is 600.
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Account Properties — Security

Properties of Account2 ﬂ

Accountl Voicemaill Topologj,ll F'resencel Storage  Security |.f5.dvanced|

Signaling Transpork

Encrypted or TLS must be selected to enable media encryption,

IMedia Encryption

' Make and accept only encrypted calls
" Brefer to make and accept encrvpted calls
& ake unencrypted calls, accept &l calls

Do not allov encrypted|calls

(] I Cancel Lpply |

Table 7: Account Properties — Security

Field

Description

Signaling Transport

Contact your VoIP service provider to identify the types of transport that are
supported. Then choose a supported transport:

e Automatic: Bria sets up the transport based on the capabilities of the network
and the Bria computer. Choose this option if you do not care which transport
isused.

« Encrypted: Currently, this option means TLS will be used. Choose this option
to request signaling encryption or both signaling and media encryption.

e TCP: Thistransport provides no signaling security.
« UDP: Thistransport provides no signaling security.

¢ TLS: Choose this option to request signaling encryption or both signaling and
media encryption.

Media Encryption

See Table 8 on page 67.
The factory setting is Make unencrypted calls, accept all calls.

Currently, security is supported, but there are no icons on the GUI to indicate whether an incoming or outgoing
call is being made with or without security.

You can set up Briafor the type of security (encryption) you want for incoming and outgoing calls.

Bria supports:

* Signaling encryption using TLS
» Mediaencryption using SRTP.

Setting up for Security outside of Bria

When using TLS, you must have the root certificate that signs the proxy's chain of certificates. In most cases,
the root certification will already be installed. Procedures for the exchange of certificates are outside the scope
of this documentation. The certificates must be stored on the Bria computer, in the root certificate store.
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Setting up the root certificate on your computer ensures that the connection to the proxy is TLS secure (the first
hop). Any proxy in the chain (between you and the caller) that does not support TLS may cause an insecure link
in the chain. Therefore, if the other party is outside your domain, you cannot be completely sure that the call is
secured at the signaling level, which means that you cannot be sure that it is secured at the medialevel.

Setting up for Security within Bria
The options for media encryption are described in the following table.

Table 8: Security Options

Option

How Outgoing Calls are Handled

How Incoming Calls Are Handled

Make and accept only
encrypted cals

Briawill place al calswith TLS. Thecall INVITE
will specify SRTP media encryption.
If the correct certificates are not in place or if the

other party does not accept encrypted calls, the call
will fail.

Briawill only accept INVITES that are for
encrypted calls.

If Briareceivesacall INVITE that is not
encrypted, the call will be rejected.

Prefer to make and
accept encrypted calls

Briawill placeall calswith TLS. Thecall INVITE
will specify SRTP media encryption.

If the correct certificates are not in place or if the
other party does not accept encrypted calls, the call
will fail. Briawill then place the call without
encryption.

Briawill accept INVITES for both encrypted and
unencrypted calls.

Make unencrypted calls,
accept al cals

Briawill place only unencrypted calls.

If the other party does not accept unencrypted
calls, the call will fail.

Briawill accept INVITES for both encrypted and
unencrypted calls.

Do not alow encrypted
call

Briawill place only unencrypted calls.

If the other party does not accept unencrypted
calls, the call will fail.

Briawill only accept INVITESthat are for
unencrypted calls.

If Briareceivesacall INVITE that is encrypted, the
call will be rejected.
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Account Properties — Advanced
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Table 9: Account Properties — Advanced

Field

Description

Reregister every

The timeinterval between Brid's attempts to reregister in order to refresh the
account registration with the Vol P service provider for this account. A value of
zero means not to reregister after the initial registration.

Thisvalueis placed in the “Expires’ header field of the REGISTER message.
The factory setting is 3600.

Min. time

If the reregistration fails, Briawill wait this amount of time, then attempt to
reregister. If the second attempt fails, Briawill wait twice thistime and try again,
then four times this time, and so on, until reregistration succeeds.

The factory setting is 20.

Max. time

Thisis the maximum wait time between attempts to reregister. Once this
maximum is reached, Briawill wait thistime for al subsequent attempts.

For example, the min. timeis 20 secs, the maximum timeis 120 secs. Briawill
attempt to reregister as follows:

e Wait 20 secs.

* Attempt to connect.

o |f fail, wait 40 secs.

e Attempt to connect.

o |f fail, wait 80 secs.

* Attempt to connect.

e If fail, wait 120 secs (the maximum)
e Attempt to connect.

« |f fail, wait 120 secs, and so on.

The factory setting is 1800.

Send SIP keep-alives

Typically on, to instruct Briato send SIP keep-alive messages in order to
maintain a*“pinhole’ through your firewall for SIP messaging.

Use rport

Typically on.

68




Bria 2.1 for Windows

Table 9: Account Properties — Advanced

Field Description

Enable session timers A session timer is amechanism to detect whether a call session is still active
from the signaling point of view. When the timer expires, arefresh is sent from
one party to the other. The timer is then reset.

¢ Turn onto enable session timer. Enter avalue in Default session time. The
factory setting is 60.

Turn off to disable session timer; refreshes will never be sent.

Session timer preference Thisfield specifies your preference for which party should send the refresh. The
preference is not a guarantee that the refresh will be performed by the specified
party. The choices are:

« None: No preference.
« Local refreshes: Your computer sends.
* Remote refreshes: The other party sends.

* UAC refreshes: The user agent client (the party that initiated establishment of
the communications) sends.

UAS refreshes: The user agent server (the other party) sends.
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A Application Hot Keys

Function Keyboard Shortcut
Answer Enter
Exit ctrl Q
Hang up Esc
Hold Period
Increase/Decrease Volume Up/Down Arrows
Mute Spacebar
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B Dialing Plan

When a call attempt is made, the call input (what you type, select or drag onto the Call display) is processed to
select the account to use and to modify the input if that is required to ensure that the call gets placed
successfully. This ability to select an account and modify the input relies on the existence of a“dialing plan” for
each account.

Theinput is processed as follows:

*  Cleanup: Input is cleaned up by removing spaces, dashes, open brackets, and close brackets. Cleanup
allows Briato support calls placed using contacts from a contact list, including Microsoft® Outlook®.

« Matching: Theinput is compared to the patterns defined by the dialing plan for each enabled account. Each
account has one dialing plan, and each dialing plan has one or more patterns.

When amatch is found between the input and the pattern, the account that this pattern belongsto is selected
and the transformation for this pattern is performed.

If no match is found, the default account is selected and no transformation is performed.
For details on matching see “How the Input |s Processed” on page 76.

»  Transformation: The selected transformation is performed.
* Thenthecal isplaced using the transformed input.

The Default Dial Plan
The default dial planis:
#n\a\a.T;match=1;prestrip=2;

where #n is the account prefix (#1 for the first account in the list (proxy0), #2 for the second account (proxy1),
and so on).

If the input is the account prefix and the number, then the Account for this dia plan is selected. The account
prefixed is stripped from the number before the call is placed.

If all Accounts use thisdial plan, then the behavior isasfollows: if the input includes the account, then that
account is used. In other words, you can force selection of a specific account by including the account prefix. If
the input does not include #n, then the default account is used.

Do You Need to Read this Information?
You do not have to read this dia plan information if the default dial plan behavior (above) is acceptable.

If you want to be able to place calls on a specific account without including the account prefix, then you must
create adial plan for one or more accounts.
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B.1 Dialing Plan Syntax

In Bria, the dialing plan establishes the expected patterns of characters for a telephone number or softphone
address, and allows for modification (transformation) of input based on the match to a pattern. The dialing plan
has the following syntax:

pattern| |pattern] ;match=1;<transformation>=<value>; [match=2;
<transformations>=<values>;]

Where:

e Itemsin[] are optional.

»  Pattern: the pattern that will be matched. One or more patterns. Each pattern is separated by a | pipe. The
pipeisoptional after the last pattern. Each pattern isimplicitly numbered, starting from 1.

* Maitch; Transformation: A pair that identifies the pattern number to compare with the input, and the
transformation to perform on the input when a match is obtained. The transformation is optional (meaning
that if thereis no transformation for a pattern, then the input that matches this pattern is not transformed).
One or more pairs.

“match="isaliteral. “n” identifies the pattern. “transformation="is replaced by a keyword, see below.
“value” isreplaced by avalue.

Spaces are allowed only in the <values items.

Example

\a\a.T|xxxxxxxxxx;match=1;prestrip=2;match=2;pre=8;
where:

» \adaTisthefirst pattern.

*  XXXXXXXXXX;is the second pattern.

» match=1;prestrip=2;is the first match-transformation pair.
* match=2;pre=8;is the second match-transformation pair.

Pattern

Valid Content

The content for a pattern follows the digit map rules of RFC 2705, supplemented by the rules for regular
expressions. Where there is an overlap between the digit map and regular expression rules, the digit map rules
apply. For this reason, there are some special cases, included in the table below.

The following table describes the most common elements. As mentioned, all regular expression elements are
supported.

Element Origin Description
0123456789 |Literals Literal digits, used asis.
#*atoz Literals Literal characters, used asis. Special cases:

» Theliteral x character is represented by \x.
» Theliterd t character isrepresented by \t.

X Digit maprules  |Wildcard for any single digit, 0to 9.
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Element Origin Description
\a Regular Wildcard for any single a phanumeric character.
expression rules
[digit-digit] Regular A digit within the specified range.
expression rules
[character- Regular A character within the specified range.
character] expression rules
[digitl, digit2, Regular One of the charactersin the collection.
digit3] expression rules
Digitmaprules  |Repeat the last element 0 or more times. For example, xxxx. means repeat the last x 0 or
more times, which means this pattern matches three or more digits (not four or more
digits)! Use of this element resultsin a pattern with “minimum requirements”.
T Digitmaprules | A timeout period will take place before automatic dialing starts.

The T timer forces Briato wait after a match is made. Thistimer should always be

included in, and situations:

* Any pattern that usesthe . (dot). For example, if the pattern is xxxx. then adding a
timer lets you type three or more digits. If there is no timer, then as soon as you type
three digits, Bria makes the match as soon as you type three digits.

» Any dialing plan that has two patterns that are similar in elements but different in
length. For example, if one pattern isxxx and the other pattern is xxxxxxx, then
adding the timer lets you continue typing past three digits, in order to get a match on
the second pattern.

In this situation, the T timer should be included in the shorter pattern.
Timers

There are two timers:

e T timeris4 seconds.
» Thelong timer is 20 seconds.

These timers are used in input comparison, as described in “How the Input Is Processed” on page 76.

Transformation Keywords

Keyword Description

prestrip Strip the first n characters from the input before
placing the call.

poststrip Remove n number of characters from the end of
the input before placing the call.

pre Add the specified account prefix to the input
before placing the call.

post Attach the specified postfix to the input before
placing the call.

replace Replaces the input with the specified string
before placing the call.

Order of Transformations

These transformations are always performed in the following order (the order in which the transformations are
entered in the dialing plan is not significant):

prestrip > poststrip > pre> post > replace
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B.2 How the Input Is Processed

Comparing Input to the Dialing Plan Patterns

Theinput is compared to each dialing plan in turn, starting with the first listed account. The processis dightly
different depending on how the call is placed:

« If theinput was dragged or selected, then the entire input is compared to each dialing plan. If acomplete
match is found, then that account is selected and the associated transformation is performed. If no match is
found, the default account is selected and no transformation is performed.

« If you aretyping the input, the digits are compared one by one as they are entered. The comparison will
result in one of the types of matches described in the table bel ow.

It is possible for the same input to get matched to different dialing plans depending on whether the input is
entered on the fly or dragged. It isimportant to keep thisin mind when designing dialing plan patterns.

Results of the Comparison

Result if You Press

Result if You Stop

for any dialing plan.

selected and no
transformation is performed.

Type of Match Conditions Enter or Dial Typing
Partial match The characterstyped so far follow the pattern but | The default account is If you stop typing for the
there are not yet enough characters for apending | selected. No transformation |long timer length (20
or complete match. is performed. seconds), then the default
account is selected. No
transformation is performed
on the characters typed so
far.
Pending match » The pattern has no . (dot) but does have the T | This pattern's account is If the T timer expires, this
timer. There is a perfect match. selected and the pattern’'s account is selected
« The pattern hasa. (dot) and the T timer. The transformation is performed. | and the transformation is
L ; performed.
minimum requirements are met.
Complete match |+ The pattern hasno . (dot) and no T timer. This pattern's account is This pattern's account is
Thereis a perfect match. selected and the associated | selected and the associated
« The pattern hasa. (dot) but does not have the transformation is performed. | transformation is performed.
T timer. The minimum requirements are met.
No match The characters typed do not match the patterns | The default account is Nothing happens even after

the T timer and long timer
have expired.
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B.3 Examples

Example 1

\a\a.T|xxxxxxx.T;match=2;pre="9"

This simple example shows how to differentiate between a PSTN number and a softphone address, and how to
add a“9” dialing prefix only to the PSTN number.

Example 2

3XXT | IxxxxxxXXXX | [2-9] xxxxxxxxX | +X.T;match=2;pre="9";
match=3;pre="91";match=4;prestrip=1;pre="9011"

3xXxT Thefirst pattern is any three-digit number beginning with 3. No transformation. The
assumption is that thisis an internal extension. The timer forces Briato wait after detecting a
three-digit number beginning with 3, in case you are actually dialing alocal call starting with
3.

TIXXXXXXXXXX The second pattern is any eleven-digit number beginning with 1. Prefix with 9 and dial asis.

The assumption is that thisis along-distance PSTN call within North America (within North
America, al long-distance calls start with 1).

[2- 9 XXXXXXXXX

The third pattern is any ten-digit number beginning with a number other than 1. The
assumption is that thisisalocal PSTN call within aten-digit dialing zone.

+X.T; The fourth pattern is anumber of any length that begins with +, to indicate an international
PSTN call from North America. Delete the +, prefix with 9011 (011 is the number to access
an international line from North America).

match=2;pre="9"; For the second pattern, prefix 9 to access an outside line.

match=3;pre="91";

For the third pattern, prefix 9 and 1 to access an outside line and enter the long-distance code.

match=4;prestrip=1;pre="9011"

For the fourth pattern, remove the + and prefix 9011 to access an outside line and enter the
international code.

Example 3

#1xxxxxxxT|#l9xxxxxxx|xxxxxxxT|9xxxxxxx|;match:l;prestrip=2;pre=9;match=2;
prestrip=2;match=3;pre=9;

HDOXXXXXXT The pattern is an acount prefix followed by seven digits. The timer forces Briato wait to
allow amatch to the second pattern. The #1 is stripped off and 9 is prepended to access an
outside line.

HLIXXXXXXX The pattern is an account prefix followed by a9 and seven digits. The #1 is stripped off.

XXXXXXXT The pattern is seven digits. The timer forces Briato wait to allow matching to the fourth
pattern. 9 is prepended to access an outside line.

OXXXXXXX The pattern isa 9 and seven digits. The input is not transformed.

This example assumes that the dialing plan belongs to the first account.

Thedialing plan is dlightly trivial, because it does not cover al the situations that a dialing plan should be
designed for (local calls, long-distance calls, international calls, and so on for the locale).

However, the example does illustrate two ideas:
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» Handling of the account prefix (#1), if you are upgrading from Bria 1.1 and are accustomed to entering the
account number.
Use of # to identify the account is now deprecated. The dialing plan should be capable of determining the
account to use for this number. However, since users may still be in the habit of entering the account prefix,
you may want to include this pattern to handle such a scenario.

» Distinguishing between alocal seven-digit call in which 9 is not dialed (to access an outside line) and one
in which 9 is dialed to access an outside line.
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C Contact List Headings

Following isalist of all the headings that are used in the Bria contact list. Thislist can be useful when
formatting a contact list in order to import it into Bria. For details, see “Importing Contacts” on page 29

uri business_number sms_addresss
display-name business_number2 ms_address2
entry_id business_number3 sms_address3
given_name business_number4 sms_address4
surname business_number5 sms_addressb
email_address business_number6 sms_addresst
email_address2 mobile_number custom fields
email_address3 mobile_number2 custom_fields2
email_address4 mobile_number3 custom_fields3
email_addressb mobile_number4 custom_fields4
email_addressb mobile_number5 pres_subscription
Sip_address mobile_number6

Sip_address2 fax_number

sip_address3 fax_number2

sip_address4 fax_number3

sip_address5 fax_number4

sip_address6 fax_number5

home_number fax_number6

home_number2 groups

home_number3 comment

home_number4 postal_address

home_number5 default_address

home_number6 default_address type
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D Location of Files

System files get copied to the installation directory specified when installing Bria. The default installation
directory is:

C:\Program Files\CounterPath\Bria

Datafiles are saved in the Counterpath folder in the standard location for application data, as defined in
Windows.This location istypically:

C:\Documents and Settings\<user name>\Application Data\CounterPath
Solutions Inc\Bria\
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E Other Ways to Run Bria

E.1 From a Hyperlink

You can attach a hyperlink to a phone number or softphone address that, when clicked, starts Briaand dials the
number. Attach a hyperlink with this format:

<a href="sip:<address or number>">dial <address or number></a>

For example:

<a href="sip:kpereira@domain.com">dial kpereira@domain.com</a>

E.2 From the Command Line

You can start Briafrom a DOS prompt. You may need to add Bria.exe to the PATH. Then type:

Bria.exe
To start Briafrom a DOS prompt and immediately dial a number, type:

Bria.exe -dial=sip:<numbers
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F Glossary

AEC

AGC

AVI

Broadband

Codec

Default account

Diding plan

DTMF

IP address
Media
MWI

Narrowband

Presence

Proxy
PSTN

Acoustic echo cancellation. Processing of the audio or video signal to reduce the echo
effect that can arise with a speakerphone or that can ariseif the sound from the
speakerphone or headphone leaks into the microphone.

Automatic gain control. Processing of the audio or video signal to adjust the
microphone volume level so that the other party does not hear the distortion that
might be caused by too high a microphone input or too low volume (due to too low
input level).

Audio Video Interleave. A multimedia container format. AV| files contain both audio
and video datain a standard container that allows simultaneous playback.

Broad or wide bandwidth. In data transmission, the wider the band, the more datait is
possible to transmit in a given time span. A cable, DSL and ADSL connection to the
network provide broadband for data transmission. A dialup or ISDN connection
typically provide a narrow bandwidth for data transmission.

The format by which audio or video streams are compressed for transmission over
networks.

The SIP account that will be used when placing an outgoing call, if Bria does not
determine that another account should be used. Bria usesthe dialing plan to determine
the account to use. You can mark one account as the default account; see “ Setting the
Default Account” on page 55.

The rules that Briafollows in order to interpret the softphone address or phone
number that the user has entered and to modify the number or address, as required, to
ensure that the call will be placed successfully.

Dual-tone multi frequency. DTMF is the system that is used in interactive voice-
response menu systems such as the menu system for accessing voicemail messages.
The DTMF system allows the user to interact with the menu by pressing keyson a
diapad or keyboard.

Instant Messaging. A technology that lets users send text message and files for near
instantaneous delivery and display on each others' computers.

Internet Protocol. A data-oriented protocol used for communicating data across a
network. IPisthe most common protocol used on the internet.

A unigue number that devices usein order to identify and communicate with each
other on a computer network using the IP standard.

In a Vol P phone call, the audio and video portion of the informationin acall.
Compareto “Signaling”.

Message Waiting Indicator. An indicator that there is a voicemail message for the
owner of an account.

In data transmission, the wider the band, the more data it is possible to transmit in a
given time span. A cable, DSL and ADSL connection to the network provide
broadband for data transmission. A dialup or ISDN connection typically provide a
narrow bandwidth for data transmission.

An instant messaging feature that allows users to share information about their
availability, mood, location and so on.

See SIP account.
Public Switch Telephone Network. The traditional 1and-line phone network.
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RFC
RTP

Signaling

SIMPLE protocol

SIP
SIP account
softphone address

SRTP

TCP

TLS

UDP

URI

URL

USB device

VAD

vCard
VolP

VoI P service provider

WAV

Request for Comment. A document that describes an aspect of an internet technol ogy.
An RFC may be a proposed, draft or full internet standard.

Real-time Transport Protocol. A protocol for delivering the media portion of a data
transmission over an IP network. SRTP is another media protocol.

In a Vol P phone call, the information in a call that deals with establishing and
controlling the connection, and managing the network. The non-signaling portion of
the call isthe Media

Session Initiation Protocol for Instant Messaging and Presence L everaging
Extensions. The instant messaging (IM) protocol followed by Bria. It encapsulate the
rules for exchanging instant messages.

Session Initiation Protocol. The signaling protocol followed by Briafor handling
phone calls.

An account that provides the user the ability to make Vol P phone calls. The account
encapsul ates the rules and functions the user can access.

The address used to connect to a SIP endpoint. In other words, the “phone number”
used in a Vol P phone call. For example, sip:joseph@domainA.com.

Secure Real-time Transport Protocol. A protocol for delivering the media portion of a
data transmission over an IP network. SRTP is a secure protocol, which means that
the mediais encrypted. RTP is another media protocol.

Transmission Control Protocol. A transport protocol for delivering data over an IP
network. Other transport protocolsare TLS and UDP,

Transport Layer Security. A transport protocol for delivering data over an IP network.
TLSisasecure transport protocol, which means that all the data being transmitted
(signaling and media) is encrypted. Other transport protocols are TCP and UDP.

User Datagram Protocol. A transport protocol for delivering data over an I P network.
Other transport protocolsare TCPand TLS.

Uniform Resource I dentifier. A name or address that identifies alocation on the world
wide web. A softphone addressis atype of URI.

Uniform Resource Locator. A URI that both identifies aname or address and indicates
how to locate it.

Universal Serial Bus device. A device that follows a specific communications
standard. A headset may be a*USB type” of headset.

Voice Activity Detection. A technology that detects if audio is ahuman voice or
background noise. Briaincludes a feature (Preserve bandwidth on the Network pane
of the Preferences window) that controls whether audio is transmitted when VAD
determines that none is actually speaking.

An electronic business card that is often attached to an email. It often appears asa
“signature” block that identifies the person, their title, and their business.

Voice over Internet Protocol. A variation of |P used for sending voice data over the
internet, in other words, used for making phone calls over the internet.

A businessthat provides a Vol P service, allowing a user to connect to the internet in
order to make Vol P phone calls using Bria. The VoI P service provider setsup a SIP
account for the user.

Or WAVE. A file format standard for storing audio on PCs.
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